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1	 About this documentation
This documentation describes the function and application of the software

ibaAnalyzer.

1.1	 Target group
This documentation is aimed at qualified professionals who are familiar with handling electrical 
and electronic modules as well as communication and measurement technology. A person is 
regarded as professional if he/she is capable of assessing safety and recognizing possible con-
sequences and risks on the basis of his/her specialist training, knowledge and experience and 
knowledge of the standard regulations.

This documentation addresses in particular professionals who are in charge of analyzing mea-
sured data and process data. Because the data is supplied by other iba products the following 
knowledge is required or at least helpful when working with ibaAnalyzer:

■	 Operating system Windows 

■	 ibaPDA (creation and structure of the measuring data files)

1.2	 Notations
In this manual, the following notations are used:

Action Notation
Menu command Menu Logic diagram
Calling the menu command Step 1 – Step 2 – Step 3 – Step x

Example:  
Select the menu Logic diagram – Add – New function 
block.

Keys <Key name>

Example: <Alt>; <F1>
Press the keys simultaneously <Key name> + <Key name>

Example: <Alt> + <Ctrl>
Buttons <Key name>

Example: <OK>; <Cancel>
Filenames, paths Filename, Path

Example: Test.docx
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1.3	 Used symbols
If safety instructions or other notes are used in this manual, they mean:

Danger!

The non-observance of this safety information may result in an imminent risk 
of death or severe injury:

■	 Observe the specified measures. 

Warning! 

The non-observance of this safety information may result in a potential risk of 
death or severe injury!

■	 Observe the specified measures. 

Caution!

The non-observance of this safety information may result in a potential risk of 
injury or material damage!

■	 Observe the specified measures 

Note 

A note specifies special requirements or actions to be observed.

Tip

Tip or example as a helpful note or insider tip to make the work a little bit easier.

Other documentation

Reference to additional documentation or further reading.
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1.4	 Documentation structure
This documentation describes the functionality of the ibaAnalyzer software in detail. It is de-
signed both as a tutorial as well as a reference document.

In addition to this documentation, you can examine the version history in the main menu, Help 
– Version history (file versions.htm), for the latest information about the installed version of 
the program. This file not only lists the bugs that have been eliminated but also refers to exten-
sions of the system in note form.

In addition, special "NewFeatures…" documentation comes with any software update that in-
cludes significant new features, which provides a more detailed description of the new features.

The state of the software to which the respective part of this documentation refers is listed in 
the revision table on page 2.

The ibaAnalyzer documentation (PDF version) is divided into six separate parts. Each part has its 
own section and page numbering beginning at 1 and is updated independently.

Part Title Content
Part 1 Introduction and Installation General notes, licenses and add-ons

Installation and program start

User interface
Part 2 Working with ibaAnalyzer Working with data file and analysis, presentation 

features, macro configuration, filter design, prefer-
ences, printing, export, interfaces to ibaHD-Server, 
ibaCapture and report generator

Part 3 Expression editor Directory of all calculation functions in the expres-
sion builder, including explanation

Part 4 Database interface Working with data from databases, connecting to 
the database, writing iba measurement data to da-
tabases, extracting the data from the database and 
analyzing the data.

Part 5 Interface for file extraction Functions and settings for extracting data from iba 
data files to external file formats

Part 6 Application examples In preparation
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2	 About ibaAnalyzer
ibaAnalyzer is a powerful tool for analyzing complex data that were recorded using the  
ibaPDA, ibaQDR, ibaLogic or ibaFiles recording programs as well as with products from other 
manufacturers (such as VISTA).

ibaAnalyzer supports fast analysis of large volumes of data and offers a variety of functions and 
algorithms to correlate measurement data from a process and interpret it meaningfully.

In addition to the traditional task of being able to present measured values from the process, 
mainly for fault analysis or machine evaluation, ibaAnalyzer fulfills a number of other features.

ibaAnalyzer is thus a powerful tool for quality data management and analyzing product-related 
data. With the upgraded functions of the database interface and of the report generator,  
ibaAnalyzer constitutes the fully integrated link between process-based and time-based mea-
suring data ("Level 1") on the one hand and product-related quality data ("Level 2/3") on the 
other. Because of its underlying structure, quality data management systems can be implement-
ed, covering both individual plants or machines and plant-wide, factory-spanning networks.

When purchasing an online data acquisition system from iba, you will receive ibaAnalyzer for 
free, with no restrictions in terms of copying or number of installations. License fees apply only 
for specific upgraded or additional features, such as those enabling automated data extraction 
to files or databases or the processing of data from external sources.

2.1	 ibaAnalyzer standard functions (no license required)
ibaAnalyzer is a software with an easy-to-use, intuitive interface, featuring dockable windows 
and drag-&-drop functionality. The following features and properties are available by default for 
comprehensive analysis of acquired measurement data.

2.1.1	 General functions

■	 Any number of graphs (trend views), each enabling the selection of the following modes:

	� Time based mode (X axis = time axis)

	� Length based mode (X axis = length axis)

	� X-Y mode with two or more signals, where each signal can be defined as X-axis

	� FFT mode

■	 Simple placement of any number of signals in the graphs using the drag & drop functionality 
(compliant with IEC 1131)

■	 Combination of data originating from different measuring processes or data sources, analog 
or digital signals as well as text signals

■	 Automatic or manual selection of colors for the curves

■	 Individual scales for every signal within a graph, or scaling of a signal in relation to any other 
signal on the same Y-axis within a graph

■	 Permanent display of the X-/Y-values for two markers as well as for the most important sta-
tistical values (min, max, average, standard deviation) for all the signals displayed
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■	 Zooming and moving of the section in a Navigator window

■	 3D view and 2D top view (profile view) of vector signals (arrays)

■	 Powerful logical, mathematical and technological functions for linking, combining, calculat-
ing and creating signals

■	 Generation of virtual signals, even multi-dimensional ones (array)

■	 A powerful digital, graphic filter designer with integrated signal generator for filter testing

■	 Flexible export function for generating new iba data files (for example, with combined or 
mathematically modified signals) and for generating text or COMTRADE files (.txt, .csv) for 
further processing by other programs (for example, document generation, spreadsheet pro-
cessing, etc.)

■	 Powerful report generator for the free design and layout of analysis, quality, production and 
fault reports with different output formats

■	 Information window: large-sized and alphanumeric display of important, calculated parame-
ters or textual information 

■	 Macro function for simplifying and reusing comprehensive analysis functions and calcula-
tions.

■	 Versatile marker functions for highlighting special measurements, including measurement 
and display of on / off times of digital signals or distances between markers

■	 Efficient management of the analyses for flexible use

■	 Multilingual program interface, switchable

■	 ibaHD-Server query

■	 Database interface

■	 Search and reference function
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2.1.2	 Expression builder

ibaAnalyzer has the so-called expression editor for the analysis of the recorded acquired values 
and execution of various calculations. This is a formula editor that offers a number of logical, 
mathematical and technological features that can be used in ibaAnalyzer at various points.

Other documentation

You can find a detailed documentation about the expression editor in part 3 of 
the manual and supplementary application examples in part 6.

2.1.3	 Map view

The map view can display geographical positions and movements based on GPS data. You can 
use recorded geographical longitude and latitude data to evaluate the positions or routes of 
goods or equipment and correlate them with high-resolution measurement data from industrial 
processes. 

With ibaAnalyzer v8.2 or higher, this function no longer requires a license (formerly 
ibaAnalyzer Maps). 

For more information, see ibaAnalyzer manual part 2, chapter Map view. 

2.1.4	 Report generator

The Report generator is an independent tool that is integrated into ibaAnalyzer. You can use the 
report generator license-free to configure, generate and publish customized reports.

Other documentation

You can find a detailed description of the functions and application in the 
ibaAnalyzer-Reportgenerator manual.

2.1.5	 ibaCapture

With ibaAnalyzer, you can also view measured value recordings and video recordings that 
ibaCapture has recorded synchronously with the measured values.

Other documentation

You can find a detailed description of the functions and application in the 
ibaCapture manual.
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2.1.6	 ibaHD-Server

In addition to the analysis of iba data files, ibaAnalyzer also offers the possibility to analyze data 
from records that were recorded with ibaHD-Server.

Using HD queries, you can call up the data from the HD store and then evaluate it as with nor-
mal data files.

Other documentation

You can find a detailed description of the functions and application in the 
ibaHD-Server manual.
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2.2	 ibaAnalyzer functions requiring a license
The functional extensions for ibaAnalyzer listed below require licenses. It is possible to subse-
quently enable the licensed features at any time.

You can obtain licenses for the functions via the usual channels.

■	 for ibaAnalyzer v8.0.0 or higher: WIBU licenses (CmStick on dongle, CMActLicense as soft 
license) via the CodeMeter Runtime program

■	 USB dongle from MARX on the computer

■	 Central ibaLicenseService-V2 in the network

2.2.1	 Database interface in ibaAnalyzer

The ibaAnalyzer database interface is a default function that can be used interactively without 
an additional license. This interface provides ETL functions (Extract Transform Load) for com-
monly used database providers and thus enables trend and detail analyses based on databases. 
The ibaAnalyzer report generator can also process data from the database interface.

An additional license is only required if you want to automate the data exchange with the data-
base. As the ibaDatCoordinator program is usually used in practice for the automated process-
ing of measurement data, an ibaDatCoordinator-DB license is needed.

To read or query databases, the ibaAnalyzer-DB-Read license is needed.

ibaAnalyzer supports SQL Server, Oracle, MySQL/Maria DB, PostgreSQL, IBM DB2, MS Access 
and SQLite.

Order number Name Comment
33.010003 ibaAnalyzer-DB-Read Read or query data from databases  

(only one user)
33.010008 ibaAnalyzer-DB-Read-5 Read or query data from databases for 5 

user at a time
34.010510 ibaDatCoordinator-DB Automated data extraction to databases 

(per task)

Table 1: 	Licenses for the database interface

Other documentation

The detailed documentation on the database interface can be found in Part 4 of 
this manual.
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2.2.2	 Data extraction into files with ibaAnalyzer

The file extract function in ibaAnalyzer is a standard function that you can use interactively 
without an additional license. The function allows you to extract measurement data acquired 
in the iba data file format into standard formats, which in turn can be imported by other pro-
grams. The measurement values and data calculated in ibaAnalyzer can thus be made available 
to other systems or analysis tools (e.g. MS Excel). The following formats are supported:

■	 iba data file (.dat)

■	 Text files (.txt, .csv)

■	 COMTRADE (.cfg)

■	 TDMS

■	 Apache Parquet

■	 Matlab (.mat)

An additional license is only required if you want to automate the data extraction. As the 
ibaDatCoordinator program is usually used in practice for the automated processing of mea-
surement data, an ibaDatCoordinator-File-Extract license is needed.

Order number Name Comment
34.010511 ibaDatCoordinator-File- 

Extract
Automated data extraction to DAT files 
or other file formats such as CSV, COM-
TRADE, Parquet, Matlab, TDMS etc.  
(per task)

34.010521 ibaDatCoordinator-File- 
Extract-10

Bundle for automated file extract 
(10 tasks)

Table 2: 	Licenses for the data file extraction

Other documentation

The detailed documentation on the interface for file extraction can be found in 
Part 5 of this manual.
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2.2.3	 Reading foreign formats (ibaAnalyzer-E-Dat)

In order to enable the analysis of data recorded using a system other than an iba system, iba 
offers an additional license (ibaAnalyzer-E-Dat) under which the import of the following file for-
mats is possible:

■	 ASCII (.txt, .csv)

■	 COMTRADE CFF (*.cff)

■	 NI TDMS (.tdm, .tdms)

■	 Vista Control (*.varc)

■	 FDA (*.das)

■	 Apache Parquet

■	 Matlab (.mat)

■	 Universal 58 binary files (*.bunv, *.uff) and universal 58 text files (*.unv)

■	 Vold Trace (*.tra), Vold Torsion (*.tor) and Vold Spline (*.spl) 

This upgrade also enables the combination of data from the most varied sources in one analysis, 
such as the results of process model calculations with real process data.

Order number Name Comment
33.010445 ibaAnalyzer-E-Dat Upgrade for the reading of external file 

formats

Table 3: 	Licenses for external file formats

Other documentation

You can find a detailed description of the functions and application in the 
ibaAnalyzer-E-Dat manual. 
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2.2.4	 Display of InSpectra modules (ibaAnalyzer-InSpectra)

ibaInSpectra is integrated into ibaAnalyzer with the InSpectra Expert view (FFT) and the Orbit 
view. Here you can create profiles and test calculations offline.

With the ibaAnalyzer-InSpectra+ license, the results of the InSpectra calculations become avail-
able in ibaAnalyzer as signals, can be exported to databases and used for further processing in 
reports or with ibaDatCoordinator.

Order number Name Comment
33.010410 ibaAnalyzer-InSpectra+ Exchange of calculation profiles with 

ibaInSpectra (ibaPDA); Calculation results 
as signals

Table 4: 	Licenses for ibaInSpectra extensions

Other documentation

You can find a detailed description of the functions and application in the 
ibaInSpectra manual. 

2.2.5	 Display of InCycle modules (ibaAnalyzer-InCycle)

ibaInCycle is integrated into ibaAnalyzer with the InCycle Expert view. Here you can create pro-
files and test calculations offline.

With the ibaAnalyzer-InCycle+ license, the results of the InCycle calculations become available in 
ibaAnalyzer as signals, can be exported to databases and used for further processing in reports 
or with ibaDatCoordinator.

Order number Name Comment
33.010411 ibaAnalyzer-InCycle+ Offline analysis of cyclic processes: 

Trending and output of InCycle results in 
ibaAnalyzer

Table 5: 	Licenses for ibaInCycle extensions

Other documentation

You can find a detailed description of the functions and application in the 
ibaInCycle manual. 
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3	 Installation and program start
This chapter provides information about the system requirements, the installation and about 
starting the program.

3.1	 System requirements

■	 PC, multi-core CPU, 2 GHz or better

■	 4 GB RAM or more for extended analyses (with video etc.)

■	 350 MB or more available hard disk space for the program

■	 Additional hard disk capacity for data files and analyses, depending on your particular appli-
cation

■	 Operating system: MS Windows 10 (x86/x64), 11 (x64);  
Windows Server 2016 (x64), 2019 (x64), 2022 (x64), 2025 (x64)

■	 .NET Framework v4.8 or higher

3.2	 Installation
You can install the software either by using the installation wizard or by using the command line.

3.2.1	 Standard installation

If an older version of ibaAnalyzer is already installed, you can simply install the new version. The 
older version of the program will be removed automatically after a query and confirmation. Set-
tings and configurations made with the older version will be retained. 

If you have a ZIP file of the new ibaAnalyzer version available (e.g. after a download), unzip it 
into any (temporary) directory. 

The "iba Software & Manuals" data storage medium has all required program files in a directory 
…\01_iba_Software\ibaAnalyzer.

Which version should you install?
You can install ibaAnalyzer in the 32-bit version and in the 64-bit version. The installer file con-
tains both variants.

The x64 version can only be installed on 64 bit operating systems.

The x86 version can be installed on both 32 bit and 64 bit operating systems.

Note

The 32 bit and 64 bit version of ibaAnalyzer cannot be installed on the same 
computer at the same time!
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The features of the 64 bit version compared to the 32 bit version are:

■	 More memory can be reserved for more extensive analyses.

■	 ibaCapture-HMI is not supported. You can therefore no longer view any ibaCapture-HMI 
videos with the 64 bit version. Only ibaCapture-ScreenCam is supported.

■	 The formats Apache Parquet and FDA are supported.

Installation steps

Note

Some installation options only appear for the initial installation and not for up-
dates. To obtain these options, you can uninstall the program manually before 
the update. 

1.	 Run the file ibaAnalyzerSetup_vx.y.z.exe.  
Follow the instructions of the installation wizard.

2.	 Accept the license agreement. 

3.	 Select the installation folder.

4.	 Select the components to be installed:

	� ibaDongleViewer  
This is not a component of  ibaAnalyzer but a separate tool with which you can easily 
query the data of the license dongle (only Marx dongles, no WIBU dongles). It is offered 
for installation with all iba programs, is optional and only needs to be installed once on a 
computer.

	� ibaManagementStudio Agent  
If you have an ibaManagementStudio server in the network, you can manage this  
 ibaAnalyzer installation with ibaManagementStudio. Activate this option to install the 
ibaManagementStudio Agent. If the program is already installed on the computer, you 
do not need to activate this option. 

5.	 Select the mode in which the program is to be executed (only for initial installation). 

6.	 Select whether a desktop icon should be created.

7.	 Click on <Next>. 

	→ The program is installed. 

8.	 Finish the installation with <Finish>.
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3.2.2	 Installing by command line

You can also start the installation of ibaAnalyzer via a command line. This is helpful for the cen-
tral software administration or when using deployment systems.

You can control how the installation proceeds with the command line switches, which are set 
after calling up the installation program.

Example Notation
ibaAnalyzerSetup_vx.y.z.exe [/VERYSILENT /SUPPRESSMSGBOXES] [/DIR="xx"]

/HELP This switch shows a message box containing all supported command line 
parameters.

/SILENT This switch installs the software in "silent mode", i.e., interaction is not re-
quired during installation. 

All installer pages are skipped except the Installing page showing the instal-
lation progress. The installer runs without specifying additional parame-
ters, as if <Next> were always pressed in the dialog. 

/VERYSILENT Works like "/SILENT" but nothing is shown.
/SUP-
PRESSMSGBOXES 

Suppresses all pop-up messages. Use this option especially in combination 
with /VERYSILENT to guarantee a completely GUI free installation. 

/TASKS= This switch allows you to specify whether a desktop icon should be created 
during installation.

Examples:

/TASKS=desktopicon

/TASKS=nodesktopicon
/DIR= Use this switch to specify the installation folder, i.e. the program folder.

Example:

/DIR="C:\Programme (x86)\iba\ibaProduct"
/LANG= This switch sets the language of the installer (by default, the language of 

the operating system is used). Possible options: de, en, es, fr, it, ja, pt, ru, 
zh.

Examples:

/LANG=en

/LANG=de

/COMPONENTS Use this switch to specify the components to be installed. Possible options: 
ibadongleviewer, ibamanagementstudio

Example:

/COMPONENTS=ibadongleviewer, ibamanagementstudio
/ForceClientClose This switch forces the closing of running ibaAnalyzer instances that would 

otherwise block the installation in order to enable the installation. Please 
note that data from the terminated instances may be lost.
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3.3	 Program start
After ibaAnalyzer had been installed, you can start the program in different ways.

3.3.1	 Starting in Windows

After installation, you can open the ibaAnalyzer program as follows:

■	 Double-click on the ibaAnalyzer icon on the desktop if available

■	 Via the Start menu All programs – ibaAnalyzer – ibaAnalyzer

Program symbol:

3.3.2	 Starting with command line

You can also start ibaAnalyzer with a (DOS) command line. This means that the program can 
also be started via batch files or from within other programs, such as ibaDatCoordinator.

You can pass various parameters at startup to perform various tasks with ibaAnalyzer. For exam-
ple, ibaAnalyzer can directly perform specific analyses, generate reports, write data to a data-
base, refresh the display cyclically with each new data file and much more.

In general, the ibaDatCoordinator program is better suited to carry out the above-mentioned 
tasks of post-processing measurement files. ibaDatCoordinator offers advantages in configuring 
the post-processing tasks and ensures their safe execution.

With the scripting task of ibaDatCoordinator, you can also call ibaAnalyzer via command line in 
scripts or batch files that are executed with ibaDatCoordinator.

3.3.2.1	 Command line syntax with unprotected data files
ibaAnalyzer.exe datfilename1 [datfilename2] … [datfilenamen] [pdofilename] [/switch]

One or more measurement files (datfilename), an analysis (pdofilename) and a switch parame-
ter (switch) can be included in the call of the program. The complete path and file names must 
be entered for data files and analysis files.

Instead of data files you can also enter HD query file names (.hdq).
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3.3.2.2	 Command line syntax with password protected data files

One or more data files (datfilename) can be opened, which are protected by a password. In case 
of different passwords per data file, the password and the data filename (separated by a pipe/
vertical bar) must be entered in quotes.

You get the vertical bar character by [Shift]+['] on a Windows IBM PC keyboard layout or by 
[Alt]+[0][1][2][4].

If the same password applies to all data files, only the first data file should be attached the pass-
word and all other data filenames follow without password and quotes.

An analysis (pdofilename) and a switch parameter (switch) can be included in the call of the pro-
gram as well. The complete path and file names must be entered for data files and analysis files.

With different passwords per data file
ibaAnalyzer.exe "datfilename1|pw1" "[datfilename2]|pw2" … "[datfilenamen]|pwn"  
[pdofilename] [/switch]

With the same password
ibaAnalyzer.exe "datfilename1|pw1" [datfilename2] … [datfilenamen] [pdofilename]  
[/switch]

With HD query files referring to ibaHD-Server with active user management
ibaAnalyzer.exe "hdqfilename|user|pw" [pdofilename] [/switch]

3.3.2.3	 Using the scripting task in ibaDatCoordinator

When using the scripting task in ibaDatCoordinator, you have to use a placeholder instead of 
the data file name to be able to access the last data file:
ibaAnalyzer.exe %f [pdofilename] [/switch]

%f: Last data file, complete path and file name (e.g. d:\dat\pda001.dat)

%g: Last data file, only file name (e.g. pda001.dat)

%h: Last data file, file name without suffix (e.g. . pda001)



22Issue 8.3

ibaAnalyzer	 Installation and program start

3.3.3	 Using the switches in the command line

The switches are particularly important when using the scripting task in ibaDatCoordinator be-
cause you can use the switches to automate complete analysis processes. However, you can also 
use the switches when starting the program manually.

Note

You need licenses to use switches for the following actions:

■	 Query data from databases with license ibaAnalyzer-DB-Read

■	 Extract data into databases with license ibaDatCoordinator-DB

■	 Extract data into files with license ibaDatCoordinator-File-Extract

You can load data files or analysis files from databases without a license via com-
mand line switches.

Possible combinations of the most important switches

Combination 
permissible 
or useful?

/sql /re-
use

/ap-
pend

/print /ex-
tract

/re-
port

/trend-
sql

/over-
view-
sql

/no-
min-
max

/au-
tore-
load

/loadnewfiles No No Yes No No No No No Yes No
/autoreload No No Yes No No No No No Yes
/nominmax Yes Yes Yes No No No Yes Yes
/overviewsql Yes Yes No Yes No Yes Yes
/trendsql Yes Yes No Yes No Yes
/report Yes No Yes Yes Yes
/extract No No Yes Yes
/print Yes No Yes
/append Yes Yes
/reuse Yes

Table 6: 	Switch combinations for the command line call-up

3.3.3.1	 Command line switch /reuse

If this switch is included in the program call, ibaAnalyzer starts, loads the specified data files 
and, if applicable, displays the results as determined by an analysis file. If another program call 
with /reuse switches follows, the new data files and, if applicable, also a new analysis are load-
ed into the existing instance of ibaAnalyzer with the old data being overwritten. This means that 
the existing instance is reused and prevents the opening of further instances.

If you automate this process, e.g. via the scripting task of ibaDatCoordinator, you can constantly 
update an analysis display with the latest measurement data.
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When starting ibaAnalyzer with the /reuse switch, a lock button appears on the left-hand side 
of the toolbar. If you click on this button, you prevent the automatic update. This allows you to 
view data at your own speed, for example. If you click on the button again, the data is updated 
again.

Example /reuse
C:\Program Files (x86)\iba\ibaAnalyzer\ibaAnalyzer.exe

D:\IBA\dat_files\pda_training021.dat D:\IBA\DBExt.pdo /reuse

If the button is not displayed, you can activate it via the menu Add or remove buttons.

3.3.3.2	 Command line switch /append

This switch appends defined data files to one another. ibaAnalyzer then displays the data files 
without gaps, one after the other in the X-direction.

In connection with the /sql switch, the results from database queries are appended to each oth-
er. You do not need a license to query files from a database.

Example /append
"C:\Program Files (x86)\iba\ibaAnalyzer\ibaAnalyzer.exe"

D:\IBA\dat_files\pda_training021.dat D:\IBA\dat_files\pda_training022.dat D:\IBA\
DBExt.pdo /append
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3.3.3.3	 Command line switch /print

This switch ensures that the measuring data can be printed as a record or log in the format de-
fined in the selected analysis file. The Windows default printer is used.

When the printout is finished or the print job is sent, ibaAnalyzer closes. In the case of an error, 
however, ibaAnalyzer remains open to display the error message.

Example /print
C:\ibaAnalyzer.exe C:\dat\pda040.dat C:\iba\speed.pdo /print

3.3.3.4	 Command line switch /extract[:filename]

The /extract switch starts ibaAnalyzer and loads the specified data file. Subsequently, the mea-
suring data is processed in accordance with the specified analysis and extracted into a database. 
During this process, no ibaAnalyzer windows are opened on the screen, i.e. the extracting pro-
cess takes place in the background. The prerequisites are that you have previously configured 
the database connection and that you have saved this database connection in the analysis file. 
For extracting data into a database, a particular license is required (ibaDatCoordinator-DB).

You can also extract the data into a file, instead of a database. In this case, you have to add the 
desired file name as parameter. For extracting data into a file, a particular license is required 
(ibaDatCoordinator-File-Extract).

Example /extract[:filename]
Extracting into a database
C:\ibaAnalyzer.exe C:\dat\pda040.dat C:\iba\dbextract.pdo /extract

Extracting into a file
C:\ibaAnalyzer.exe C:\dat\pda040.dat C:\iba\txt.pdo /extract:"c:\output.txt"

3.3.3.5	 Command line switch /report[:filename]

With this switch, ibaAnalyzer starts, loads a specified data file and performs an analysis in accor-
dance with the specified analysis. Thereafter, the integrated report generator is started, and the 
data is printed on the Windows default printer using a report layout specified in the analysis if 
the [:filename] option was not used with the switch.

If you use the [:filename] switch option, the report is written to a file instead of being printed. 
You specify the desired file type using the file name extension. Many customary formats are 
supported, including, for example, .pdf, .htm, .rtf, .tiff, .jpg, .xls.

Example /report[:filename]
Print report
C:\ibaAnalyzer.exe C:\dat\pda040.dat C:\iba\rep.pdo /report

Save report to PDF
C:\ibaAnalyzer.exe C:\dat\pda040.dat C:\iba\rep.pdo /report:"c:\repout.pdf"
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You can also create the report using database queries. After a standard or trend query, you can 
create a report with the selected data. Use the corresponding file extensions .sql or .pdo.

Example /report[:filename] using a database query
C:\ibaAnalyzer.exe /sql:"C:\iba\merge.sql";sync:"STRIP_ID" 8 C:\iba\strip_rep.
pdo /report:"c:\tmp\repout.pdf"

3.3.3.6	 Command line switch /sql:filename.sql[;sync:"syncFieldName"]

This switch is used for database queries. You can use the :filename.sql parameter to transfer 
SQL statements to be used for the database query. You can use the additional, optional sync pa-
rameter to specify a grouping criterion for the query data. For querying data from a database, a 
particular license is required (ibaAnalyzer-DB-Read).

Example /sql:filename.sql[;sync:"syncFieldName"]
C:\ibaAnalyzer.exe C:\iba\dbquery.pdo /sql:"C:\iba\query.sql"

query.sql from in this example could read like this:
SELECT * FROM PDA_File order by [_Timestamp] DESC;

Example with sync parameter
C:\ibaAnalyzer.exe C:\iba\dbmerge.pdo /sql:"C:\iba\merge.sql";sync:"STRIP_ID"

The query.sql file from the example must be a text file in the SQL language supported by the 
database system specified in the PDO file (e.g. Oracle, SQL Server, DB2).

The second example shows the use of the /sql switch together with the sync parameter. The 
name of the sync field (here "STRIP_ID") corresponds to the sync field of the database that was 
specified in the SQL queries dialog. See also part 4 of the ibaAnalyzer manual, chapter Query 
builder.

If data files are specified and the /sql switch is used, all data files from the second line onwards 
are placed in the signal tree. If the query was successful, the first position contains the first file 
in the query result. Otherwise, the first line is empty.

3.3.3.7	 Command line switch /trendsql:filename.sql[;sync:"syncField-
Name";msec]

In comparison to the /sql:filename.sql switch, the /trendsql:filename.sql switch is used to query 
the info fields and computed columns from a database. You can use the :filename.sql parameter 
to transfer SQL statements to be used for the database query. A TimeStamp column must be 
selected in this query. For querying data from a database, a particular license is required  
(ibaAnalyzer-DB-Read).

ibaAnalyzer starts and queries the database specified in the PDO file with the SQL statement 
from the trend.sql file. The query results, i.e. signals with measuring points from the time 
stamp column as well as info fields and computed columns, are displayed in the Trend query re-
sult node and can be used in the analysis.

The filename.sql file must be a text file in the SQL language supported by the database sys-
tem specified in the PDO file (e.g. Oracle, SQL Server, DB2). You can load and execute this file 
using the Trend query dialog, among other things.
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In addition, the SQL statement returns a result set with a timestamp field and at least one nu-
meric field. In addition, the statement must contain an ORDER BY clause for the timestamp. The 
included SQL statement must have at least one numeric field and one result set with a time-
stamp field. (Several result sets can be present, but only the first entry is referenced).

Optionally, a synchronization field can be transferred with the sync parameter for the query.

If you use the msec option, the first numerical column of the query is used as the microsecond 
value of the timestamp.

Example /trendsql:filename.sql[;sync:"syncFieldName";msec]
C:\ibaAnalyzer.exe C:\iba\dbtrend.pdo /trendsql:"C:\iba\trend.sql"

C:\ibaAnalyzer.exe C:\iba\dbtrend.pdo /trendsql:"C:\iba\trend.sql";sync:"SID"

3.3.3.8	 Command line switch /overviewsql:filename.sql[;sync:"syncField-
Name";msec]

This switch is similar to the /trendsql:filename.sql switch. The difference is that it displays the 
query results in the Overview tab and not in the signal tree. See also part 4 of the ibaAnalyzer 
manual, chapter Trend queries.

You can combine the /sql switch with the /overviewsql switch. This enables you to start 
ibaAnalyzer with an overview and query files from the database at the same time. In this case, 
you must specify separate SQL statements for the overview and the file query in different text 
files. For querying data from a database, a particular license is required (ibaAnalyzer-DB-Read).

Example /overviewsql:filename.sql
C:\ibaAnalyzer.exe /overviewsql:"C:\iba\overview.sql" /sql:"C:\iba\query.sql"

3.3.3.9	 Command line switch /nominmax

This switch starts ibaAnalyzer without the buttons for minimizing and maximizing the program 
window.

Start without switch Start with /nominmax switch

3.3.3.10	 Command line switch /autoreload

This switch is used for automatically and periodically reloading the data files while they are still 
being written.

This function is equivalent to clicking the Auto reload files button.

For more information, see part 2 of the ibaAnalyzer manual, chapter Process-synchronous anal-
ysis.
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3.3.3.11	 Command line switch /loadnewfiles

This switch is used for the automated search and loading of a data file that is still being written 
in the set folder.

The function is equivalent to clicking the Automatically load new data files from specified direc-
tory button.

For more information, see part 2 of the ibaAnalyzer manual, chapter Process-synchronous anal-
ysis.

3.3.3.12	 Command line switch /dbPDO

This switch opens analysis (*.pdo) that are stored in a database. You only need to configure the 
database connection. Loading the analysis from the database does not require a special license.

Only add the desired analysis name – as it was stored in the database – after the colon.

Example /dbPDO
C:\ibaAnalyzer.exe /dbPDO:AnalysesSpeed

For more information about database connections, see part 2 of the ibaAnalyzer manual, chap-
ter Opening an analysis, and part 4, chapter Configuring the database connection.

3.3.3.13	 Command line switch /filetree

This switch starts ibaAnalyzer with a predefined signal tree or file tree. Using this switch, you 
can open several measurement files both on an equal footing and attached to each other.

Example /filetree
C:\ibaAnalyzer.exe /filetree:MyFileTree.txt

You must have previously exported the desired configuration of the file tree as a text file (here 
MyFileTree.txt). This file is transferred as parameter with the switch.

You can find information on exporting and importing a file tree in part 2 of the ibaAnalyzer man-
ual, chapter Exporting/importing the file tree.

3.3.3.14	 Command line switch /language

This switch starts ibaAnalyzer in the specified language. If no language is specified, ibaAnalyzer 
starts in the system language or in English.

At the moment, the following variants are available:

■	 /english

■	 /german

■	 /french

■	 /spanish

■	 /russian

■	 /chinese

■	 /italian

■	 /japanese
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4	 User interface
This chapter provides information about the main screen, menus, tool bars and hot keys.

4.1	 The screen
The start screen of ibaAnalyzer offers various areas for your tasks. The following chapters de-
scribe the individual areas in detail.

1 Menu bar
2 Toolbar
3 Recorder window/Signal window
4 Signal table (Signal definition, Markers, Statistics) + Navigator + Harmonic markers + 

Overview of trend query + Cross-reference
5 Tabs to switch windows of pos. 4
6 Status bar
7 Signal tree + Search function + Report information + Analysis files

4.1.1	 Smart Docking

You can freely move and dock (smart docking) all partial windows or tabs (numbers 4, 5 and 7 
in ì Program start, page 20). You can also arrange the menu bar, toolbars, video windows of 
ibaCapture or ibaInSpectra windows freely. Only the recorder window and status bar cannot be 
moved.
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The windows can be:

■	 Free-floating, independent of the main window  
 (i.e. also outside the main window)

■	 Docked to the border of the main window (above, below, right or left)

■	 Docked to another partial window

■	 Grouped as tabs in a new partial window which in turn can also be docked or placed freely 
floating.

Use the smart docking function using of drag & drop by clicking with the mouse on the caption 
of a partial window or a tab and dragging the mouse.

The partial window will be released and is now freely floating. Indicators appear at the same 
time. For each window the mouse is currently placed on, suitable indicators are displayed. Usu-
ally, 4 indicators for the edge positions within the main window appear and 5 indicators for the 
partial window (edges and tab) on which the mouse is currently being placed.

For docking, position the window/mouse on the desired indicator and drop it.

In the above figure, the Report info tab was released from the compound of the signal tree 
window and positioned on the window of the signal table. The indicators of the main window 
(green) and of the partial window (red) appear.

Tip

Using the command Reset window layout in the View menu, you can reset the 
arrangement of the windows back to the default setting.



30Issue 8.3

ibaAnalyzer	 User interface

4.1.2	 Generating and moving tabs

With smart docking, you can group the partial windows as you wish and place them on top of 
each other as tabs. For this purpose, drop the released partial window on the central indicator 
of the desired target window.

The partial window is then inserted in the window as last tab.

You can change the tab order using drag & drop. Make sure not to leave the tab area, as other-
wise the window will be released again.

4.1.3	 Hiding windows manually

You can close or hide partial windows and tabs by clicking on the <x> button.

In order to reopen partial windows, select the View menu. All partial windows are listed here. A 
checkmark in front of the names shows that a window is being displayed. Activate the box again 
if you want to reopen the window.
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4.1.4	 Hiding windows automatically

Each partial window can be configured in such a way that it automatically disappears if it is not 
needed.

Such a window only becomes visible if you place the mouse on the corresponding tab at the 
border of the main window. As soon as the cursor is placed on the tab, the window opens and 
thereby covers other windows. If you move the cursor from the tab or the window, the window 
closes again unless you put the focus on the window with only a mouse click.

As long as the window has the focus, it remains open. If you click on another window or execute 
another function, the window closes again.

To configure a window for automatic hiding, click on the pin icon in the window caption.

If the automatic hide function shall be deactivated, click again on the pin icon while the window 
is open.

Depending on where the windows are docked, the tabs of the hidden windows are displayed at 
the border of the main window.



32Issue 8.3

ibaAnalyzer	 User interface

4.1.5	 Scaling windows automatically

If you have opened several windows in tiled windows, it might make sense to arrange them at 
the same height or width in columns or rows.

There is an automatic function that simplifies the arrangement of an analysis view, e.g. if you 
want to show a lot of ibaCapture windows.

1.	 Roughly arrange the windows in columns or rows. 

2.	 Right-click on the caption of one of the windows in the column/row.

3.	 Select Make panes in row same width or Make panes in column same height in the opening 
context menu. 

→	 As shown in the example figure, the windows are then distributed at the same height across 
the column.
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4.2	 The menu bar
The following chapters explain the functions of the individual menus.

When you click on the ibaAnalyzer symbol in the upper left corner (window header), a menu 
appears where you can minimize, move, resize or close the current window of ibaAnalyzer. The 
Close command or double-clicking the icon closes the current window.

4.2.1	 The File menu

In the menu File, you can find the following functions.

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Analysis file functions

Symbol Function Description
New analysis Discards all current views, analysis functions, newly created 

signals and expressions, database configurations, etc., de-
letes the graphs and clearing the signal table. Loaded data 
files are retained in the signal tree.

Open analysis Open an existing analysis file (*.pdo) via browsing function.

Save analysis Saves the current analysis file.

Save analysis as Saves the current analysis in an analysis file with a new name 
(via browsing function).

Retrieve analysis 
from database

Open an analysis that had been stored in a database.

Store analysis in da-
tabase

Save the current analysis in a database.

Analysis password 
protection

Opens the dialog to edit the password for protection of the 
analysis (create, change or remove a password).

For further information, see part 2 of the ibaAnalyzer manual, chapter The Analysis. 
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Data file functions

Symbol Function Description
Open data file Open one or more existing data files (*.dat) using the Open 

new data file dialog.
Add new data file Open further data files, which are displayed in the signal tree 

window on the same level, using the Add new data file dia-
log.

Replace data file Replace the file that is marked in the signal tree window with 
a new file using the Replace the selected data file dialog. 

Append data file Open further files and append these to the existing files us-
ing the Open data file dialog. ibaAnalyzer displays these files 
in a cascaded form in the signal tree window and the mea-
sured-value trends of the individual files one after another 
along the time axis.

Close selected file Closes the file that is marked in the signal tree window and 
removes it from the signal tree window. Analysis settings and 
expressions remain unaffected.

Close all data files Closes all files in the signal tree window and removes them 
from the signal tree window. Analysis settings and expres-
sions remain unaffected.

Reload data files Reloads (refreshes) the file that is marked in the signal tree 
window.

Auto reload data files Automatically reloads the first (topmost) file in the signal 
tree window cyclically according to a set time, even if this file 
is currently being written by ibaPDA (process-synchronous 
analysis).

Auto load new data 
files

ibaAnalyzer searches in a pre-set directory for the data file 
that is currently being written by ibaPDA and loads it (pro-
cess-synchronous analysis).

Clear data file pass-
word

Deletes any saved data file passwords. The next time, you 
open a password protected file, you need to enter the pass-
word again.

For further information, see part 2 of the ibaAnalyzer manual, chapter The data file. 

Export

Symbol Function Description
Export Opens the dialog for exporting the measuring and analysis 

data into another file format.

For further information, see part 2 of the ibaAnalyzer manual, chapter Data export. 
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Print and report functions

Symbol Function Description
Print Starts the Windows print function

Print preview Shows the anticipated result of the print process. In the print 
preview, you can add additional information from the file 
information as well as literal text to be printed. You can save 
these additions in the analysis.

Print setup Opens the Windows printer setup dialog.
Report Opens the configuration dialog of the report generator. The 

report generator offers more design options for analysis re-
ports than the simple print function.

For this, also see the manual ibaAnalyzer-Reportgenerator. 

For further information, see part 2 of the ibaAnalyzer manual, chapter Print function (Hard-
copy). 

Further Functions

Function Description
Recent analysis files Shows a list of the recently opened analysis files for quick 

access to these files.
Recent data files Shows a list of the recently opened data files for quick access 

to these files.
Exit Exits ibaAnalyzer.

4.2.2	 The Database menu

This menu contains all functions for the database interface of ibaAnalyzer. 

Symbol Function Description
Database connection Opens the dialog for configuring the database connection.

See also part 4, chapter Configuring the database connec-
tion.

Query builder Opens the dialog for the standard query without SQL knowl-
edge.

See also part 4, chapter Query builder.
SQL query Opens the dialog for the query in SQL syntax

See also part 4, chapter SQL queries.
Trend query builder Opens the dialog for the trend query without SQL knowl-

edge.

See also part 4, chapter Trend query builder.
SQL trend query Opens the dialog for the trend query in SQL syntax

See also part 4, chapter SQL trend queries.
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Symbol Function Description
Abort query Cancels all currently running queries.

Data Extractor Opens the dialog for configuring the data extraction. Here 
you can extract data to a file or a database.

See also part 4 and part 5 in the chapter Data extractor.

Detailed information on this menu and the database interface can be found in part 4 of the 
ibaAnalyzer manual.

Detailed information on file extraction via the Data extractor can be found in part 5 of the 
ibaAnalyzer manual.

4.2.3	 The Historical Data menu

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Symbol Function Description
New HD Query Opens the dialog for configuring a new HD query. After ex-

ecuting the query, the result is displayed in the signal tree. 
Data files or former HD queries available in the signal tree 
are replaced.

Add HD Query Opens the dialog for configuring a new HD query. After exe-
cuting the query, the result is displayed in the signal tree in 
addition to possibly existing data files or former HD queries.

Replace File by HD 
query

Opens the dialog for configuring a new HD query. After exe-
cuting the query, the result replaces a data file or HD query 
having been marked in the signal tree before.

Append HD query Opens the dialog for configuring a new HD query. After exe-
cuting the query, the result is appended to the bottommost 
data file or HD query in the signal tree. If one of several data 
files or HD queries in the signal tree was marked beforehand, 
the result of the new HD query is attached to the checked file 
or HD query.

HD Signal Condition 
Query Abort

Cancels an ongoing HD query for signal condition, e.g. if it 
takes too long due to too much data.

For further information, see part 2 of the ibaAnalyzer manual, chapter Configuration of 
ibaHD-Server connection and HD queries.
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4.2.4	 The Edit menu

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Symbol Function Description
Undo

Redo

These commands undo actions, e.g. accidentally deleting ex-
pressions. You can also restore undone actions (redo).

You can enable or disable this function in the Preferences or 
Graph setup under Signal grid. There you can also set the 
number of operation steps in the undo stack.

See also ì The signal table, page 67.
Copy Copies the current content of the recorder window to the 

Windows clipboard, i.e. the visible graphs and the signal 
table. From there, you can insert the content as an HTML 
object into other Windows programs, e.g. Word or Excel. This 
allows you to use analyses in other documents.

See also part 2, chapter Using views in other programs.
Paste Pastes the content of the clipboard into the current 

ibaAnalyzer window. If you have previously copied in 
ibaAnalyzer, you can add the same graphs and table rows to 
the view again.

4.2.5	 The Setup menu

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Symbol Function Description
Graph setup Opens the dialog window Graph setup for the settings avail-

able for the graph currently selected (X-axis, Y-axis, display 
types, etc.). A change in current graph settings does not lead 
to a change in Preferences.

See also part 2, chapter Settings. 
Preferences Opens the dialog window Preferences, which summarizes all 

possible settings for the graph together with some general 
settings. The preferences are applied to a new analysis or 
when creating a new graph.

See also part 2, chapter Settings. 
Export/import prefer-
ences

Export and import the current preferences as INI file. In this 
way, you can save optimized preferences and make them 
available to other users. When executing these commands, 
specify the path and file name of the INI file. In the Prefer-
ences dialog under Export/Import, you can find further set-
tings for the export and import of the preferences have to be 
configured.

See also part 2, chapter Export/import settings. 



38Issue 8.3

ibaAnalyzer	 User interface

Symbol Function Description
Autoscale all Automatically scales all the signals displayed in the Y-direc-

tion on all displayed graphs. The X-axis is not affected by 
this operation, so that a zoomed time section remains un-
changed.

Restore manual scale Restores the original manual scaling of the graph if you have 
specified manual scaling in the Graph setup but you have 
changed the view in the graph, e.g. by changing the scale or 
zooming. This effect of this command is limited to the cur-
rently selected graph.

Auto map signal col-
ors

Automatically assigns preset colors to the different signal 
curves within the currently selected graph. You can change 
the coloring in the Preferences under Colors.

Logical expressions Opens the dialog for logical signal definitions, where you can 
define artificial or "virtual" signals as well as multidimension-
al signals (arrays).

See also part 2, chapter Logical expressions. 
Digital filter design Opens the graphic editor for digital filter design.

See also part 2, chapter Filter editor. 
Macro design Opens the dialog for generating macros. You can combine ex-

tensive calculations and complex analysis functions in macros 
so that you can use them more easily and repeatedly.

See also part 2, chapter Macros. 

4.2.6	 The Graph Mode menu

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

X-axis mode
Using the toolbar you can select different X-axis modes.

These commands apply to the graph currently marked.

The current settings of the graph in focus when calling up the menu are highlighted in the 
menu.

Symbol Function Description
Time based Sets the X-axis as time axis (default setting) from the time of 

commencing the recording process until the end of recording 
in the data file. In the Graph setup, you can switch between 
absolute time values (hh:mm:ss) and relative time (0 … n s).

See also part 2, chapter X-axis modes Time based and Length 
based. 
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Symbol Function Description
Fast Fourier (time 
based)

Shows a FFT representation of the signals in the respective 
graph with a frequency axis (1/s, Hz) as the X-axis. The ampli-
tudes of the frequency spectrum are displayed in Y-direction. 
The transformation and scaling functions are carried out as 
set in the preferences.

See also part 2, chapter X-axis mode FFT. 
Length based Divides the X-axis into length units (m) related to the dis-

played signal. As a requirement for display, the signal to be 
presented must have been converted from a time to a length 
base, for example, by a TimeToLength function.

See also part 2, chapter X-axis modes Time based and Length 
based.

Fast Fourier (length 
based)

Shows a FFT representation of the signals in the respective 
graph with a reciprocal length axis (1/m) as the X-axis. The 
amplitudes of the frequency spectrum are displayed in Y-di-
rection. The transformation and scaling functions are carried 
out as set in the preferences. 

See also part 2, chapter X-axis mode FFT. 
X - Y Only available when a graph contains at least two signals. 

This mode ignores the time or length axis and plots one sig-
nal above the other. In this way, it is possible to show depen-
dencies of one or more signals on another signal. Which sig-
nal is plotted on the X-axis and which signal is plotted on the 
Y-axis depends on the signal arrangement in the graph. The 
function is available for both time based and length based 
signals.

See also part 2, chapter X-axis mode X - Y. 

For information on time-length-conversion, see part 3 of the ibaAnalyzer manual, chapter Ex-
pression builder, chapter Conversion from time to length reference (TimeToLength). 

Views

Symbol Function Description
Standard view The standard displays a two-dimensional curve and is select-

ed by default.

See also part 2, chapter Standard view. 
2D top view Despite 2-dimensional presentation, this view also offers in-

formation on a third dimension by displaying the amplitudes 
of the measured values in colors. This view is particularly 
suitable for the presentation of profiles (temperature, thick-
ness, shape profiles, etc.).

For this, also see part 2, chapter 2D top view. 
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Symbol Function Description
3D wireframe This view shows the measured signals as a three-dimensional 

"mountain" which solely consists of lines that connect the 
samples to each other. In the setup for the 3D display (Prefer-
ences or Graph setup), you can change the resolution of the 
line mesh (B-Splines).

See also part 2, chapter 3D Wireframe. 
3D surface This view shows a three-dimensional false-color presentation 

of the measured signals. Different colors (as selected in the 
setup) are assigned to amplitudes of the signals. Depending 
on the settings in the Preferences or Graph setup, you can 
display the spaces between the measured values sharply 
separated or with color transitions.

See also part 3, chapter 3D Surface. 
Markers Opens the configuration dialog for the X-axis markers and the 

commands for setting markets at the current positions of lin-
ear X1 and X2. In addition, you can clear the existing markers.

See also part 2, chapter Markers. 
Intervals Opens the configuration dialog for displaying defined inter-

vals and the command for the interval display between cur-
rent existing markers. In addition, you can clear the existing 
intervals.

See also part 2, chapter Intervals in graphs.
Show cross profiles This command is only available in the 2D top view and en-

ables/disables the display of cross profiles.

See also part 2, chapter 2D top view. 



41Issue 8.3

ibaAnalyzer	 User interface

4.2.7	 The File Group menu

The menu items are only activated if a group of data files is opened.

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Symbol Function Description
To Trend query Opens the trend query dialog for info fields of the elements 

in the file group.

See also part 2, chapter Trend query from file groups or time 
periods.

Clear Deletes the group of data files.

Next/

Previous

Loads the next or previous data file in the group relative to 
the file currently loaded in the signal tree.

Slide Show Starts and stops the automatic display of all the data files in 
the group of files (successively).

See also part 2, chapter Slide show.

For further information, see part 2 of the ibaAnalyzer manual, chapter Defining groups of data 
files. 

4.2.8	 The View menu

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Screen settings

Function Description
Toolbar Setup Opens the dialog for customizing the toolbars (similar to  

Microsoft programs).
Status Bar, Signal Tree, Signal 
Search, Signal Grid, Report 
Info, Analysis Tree, Marker 
Grid, Statistics Grid, Harmonic 
Markers Grid, Navigator, Over-
view, Cross-reference, and Au-
dio Player

Switches the corresponding screen areas on or off (toggle), 
e.g. to create more space for the graph display. Sub-windows 
that had been bound to certain areas as tabs before are 
placed and enabled individually.

Reset window layout Resets all changes to the layout since the last start of 
ibaAnalyzer.
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Views

Symbol Function Description
InSpectra-Expert Opens an FFT view for InSpectra Expert modules in a new 

window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInSpectra.

InSpectra-Orbit Opens an Orbit view for InSpectra Orbit modules in a new 
window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInSpectra.

PDA trend Opens a trend view like in ibaPDA in a new window, which 
can be positioned freely.

Maps Opens a map view in a new window, which can be positioned 
freely.

InCycle-Expert Opens an InCycle-Expert view for InCycle Expert modules in a 
new window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInCycle.

Computation module Opens a computation module view in a new window, which 
can be positioned freely.

Event table Opens an ibaHD event table in a new window, which can be 
positioned freely.

Zoom functions

Symbol Function Description
Zoom out Zooms out one zoom level (incrementally) from a zoomed-in 

display. The command affects the currently selected graph 
and all other graphs that have the same X-axis basis (time, 
length, FFT).

Zoom out all Resets all zoom factors in all graphs, regardless of which 
graph is selected and whether there are different X-axes.

Drill-down functions (HD-Query)
Drill-down functions only apply to trend graphs of HD-Queries.

Symbol Function Description
Drill down This command is only available after a trend graph of an 

HD-Query has been zoomed in. It provides for higher resolu-
tion measured data in the zoomed area by reloading the data 
from the HD store.

Undo Drill down This command is only available after a trend graph of an 
HD-Query has been zoomed in. The drill-down is undone, 
and the view is fully zoomed out.
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Symbol Function Description
Update info fields This command is only available for queried time periods and 

it opens a dialog in which you can update the info fields of 
the time periods.

For more information, see part 2 of the ibaAnalyzer manual, chapter Access to HD data with 
ibaAnalyzer. 

General view settings

Function Description
Language In the sub-menu, you can select the display language for ibaAnalyzer. 

When switching languages, ibaAnalyzer restarts automatically. The 
System option uses the region and language settings of the Windows 
control panel.

Application style In the sub-menu, you can select a different style for the user interface 
of ibaAnalyzer. Available are different display styles and color schemes 
with reference to different Microsoft products. The changes apply to 
colors and shades of windows and controls. ibaAnalyzer immediately 
adopts a change in the application style without restarting.

4.2.9	 The Help menu

Function Description
Help Opens the Help file.
Support Opens a page with the contact information for iba locations worldwide.
Save information for 
iba support

Creates a ZIP file that contains all important information for the iba sup-
port, e.g. log files, license information and software information. You 
can also select files for the iba support, e.g. analysis files and measure-
ment files. It is generally recommended that you send a current support 
file to the iba support if a problem occurs.

Version history Opens a page that chronologically documents all changes of the 
ibaAnalyzer program up to the current version. In addition to bug fixes, 
you can also find key information on improvements and new features.

About ibaAnalyzer Shows information about the version of ibaAnalyzer.
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4.3	 The toolbar
ibaAnalyzer offers several toolbars so that you can use all functions. You can show, hide and 
change the toolbars and add user-defined toolbars.

The functions of the buttons in the toolbar are similar to the corresponding menu items, see 
ì The menu bar, page 33.

4.3.1	 Symbols and functions

You can select most functions both via the menu as well as via the corresponding buttons in the 
toolbar.

Main toolbar

This toolbar contains all basic functions which can be grouped by different categories.

File functions

Symbol Function Description
New analysis Discards all current views, analysis functions, newly created 

signals and expressions, database configurations, etc., de-
letes the graphs and clears the signal table. Loaded data files 
remain in the signal tree.

Open analysis Open an existing analysis file (*.pdo).

Save analysis Saves the current analysis as analysis file.

Open data file Open one or more existing data files (*.dat) using the Open 
new data file dialog.

Add new data file Open further data files, which are displayed in the signal tree 
window on the same level, using the Add new data file dia-
log.

Database functions

Symbol Function Description
Database connection Opens the dialog for configuring the database connection.

See also part 4, chapter Configuring the database connec-
tion.

Query builder Opens the dialog for the standard query without SQL knowl-
edge.

See also part 4, chapter Query builder.
SQL query Opens the dialog for the query in SQL syntax

See also part 4, chapter SQL queries.
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Symbol Function Description
Trend query builder Opens the dialog for the trend query without SQL knowl-

edge.

See also part 4, chapter Trend query builder.
SQL trend query Opens the dialog for the trend query in SQL syntax

See also part 4, chapter SQL trend queries.
Abort query Cancels all currently running queries.

Data extractor Opens the dialog for configuring the data extraction. Here 
you can extract data to a file or a database.

See also part 4 and part 5 in the chapter Data extractor.

Historical data

Symbol Function Description
New HD query Opens the dialog for configuring a new HD query. After ex-

ecuting the query, the result is displayed in the signal tree. 
Data files or former HD queries available in the signal tree 
are replaced.

Add HD query Opens the dialog for configuring a new HD query. After exe-
cuting the query, the result is displayed in the signal tree in 
addition to possibly existing data files or former HD queries.

Abort HD signal con-
dition query

Cancels an ongoing HD query for signal condition, e.g. if it 
takes too long due to too much data.

Drill down This command is only available after a trend graph of an 
HD-Query has been zoomed in. It provides for higher resolu-
tion measured data in the zoomed area by reloading the data 
from the HD store.

Undo Drill down This command is only available after a trend graph of an 
HD-Query has been zoomed in. The drill-down is undone, 
and the view is fully zoomed out.

Update info fields This command is only available for queried time periods and 
it opens a dialog in which you can update the info fields of 
the time periods.

For more information, see part 2 of the ibaAnalyzer manual, chapter Access to HD data with 
ibaAnalyzer.
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Editing and printing

Symbol Function Description
Copy Copies the current content of the recorder window to the 

Windows clipboard, i.e. the visible graphs and the signal 
table. From there, you can insert the content as an HTML 
object into other Windows programs, e.g. Word or Excel. This 
allows you to use analyses in other documents.

See also part 2, chapter Using views in other programs.
Paste Pastes the content of the clipboard into the current 

ibaAnalyzer window. If you have previously copied in 
ibaAnalyzer, you can add the same graphs and table rows to 
the view again.

Undo

Redo

These commands undo actions, e.g. accidentally deleting ex-
pressions. You can also restore undone actions (redo).

You can activate or deactivate this function in the preferenc-
es or graph setup Signal grid. You can also set the number of 
operations to be undone there.

See also ì The signal table, page 67.

Preferences

Symbol Function Description
Preferences Opens the Preferences dialog, which summarizes all possible 

graph settings and some general settings. The preferences 
are applied to a new analysis and when creating a new graph.

See also part 2, chapter Settings here.

Display functions

Symbol Function Description
Auto map signal col-
ors

Automatically assigns preset colors to the signal curves with-
in the currently selected graph. You can change the coloring 
in the Preferences under Colors.

Autoscale all Automatically scales all displayed signals in the Y-direction in 
all displayed graphs. The X-axis is not affected by this opera-
tion, so that a zoomed time section remains unchanged.

Restore manual scale Restores the original manual scaling of the graph if you 
have specified manual scaling in the Graph setup and have 
changed the view in the graph, e.g. by changing the scale or 
zooming. This effect of this command is limited to the cur-
rently selected graph.

Zoom out Zooms out one zoom level (incrementally) from a zoomed-in 
display. The command affects the currently selected graph 
and all other graphs that have the same X-axis basis (time, 
length, FFT).
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Symbol Function Description
Zoom out all Resets all zoom factors in all graphs, regardless of which 

graph is selected and whether there are different X-axes.
X-axis mode Set the X-axis mode of the selected graph here.

See also ì The Graph Mode menu, page 38.
View mode Set the view mode of the selected graph here.

See also ì The Graph Mode menu, page 38.

Logical signal definition

Symbol Function Description
Logical Expressions Opens the dialog for the logical signal definitions, where you 

can define artificial or "virtual" signals as well as multidimen-
sional signals (arrays).

See also part 2, chapter Logical expressions.

Filter editor

Symbol Function Description
Digital filter design Opens the graphical editor for the digital filter design.

See also part 2, chapter Filter editor.

Macro designer

Symbol Function Description
Macro design Opens the dialog for creating macros. You can combine ex-

tensive calculations and complex analysis functions in macros 
so that they can be used more easily and repeatedly.

See also part 2, chapter Macros.

Views

Symbol Function Description
InSpectra-Expert Opens an FFT view for InSpectra Expert modules in a new 

window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInSpectra.

InSpectra-Orbit Opens an Orbit view for InSpectra Orbit modules in a new 
window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInSpectra.

PDA trend Opens a trend graph like in ibaPDA in a new window, which 
can be positioned freely.

Maps Opens a map view in a new window, which can be positioned 
freely.
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Symbol Function Description
InCycle-Expert Opens an InCycle-Expert view for InCycle Expert modules in a 

new window, which can be positioned freely.

You can find a detailed description in the documentation 
about the product ibaInCycle.

Computation module Opens a computation module view in a new window, which 
can be positioned freely.

Event table Opens an ibaHD event table in a new window, which can be 
positioned freely.

Data file group

Symbol Function Description
Next/

Previous

Loads the next or previous data file in the group relative to 
the file currently loaded in the signal tree.

Slide show Starts or stops the automatic display of all data files in the 
file group (one after the other).

See also part 2, chapter Slide show.
To trend query Opens the trend query dialog for info fields of the elements 

in the file group.

See also part 2, chapter Trend query from file groups or time 
periods.

Clear Deletes the data file group.

Reloading

Symbol Function Description
Reload data files Reloads the file that is selected in the signal tree window (re-

fresh).
Automatically reload 
measurement file(s)

Automatically reloads the first (topmost) file in the signal 
tree window cyclically according to a set time, even if this file 
is currently being written by ibaPDA (process-synchronous 
analysis).

Automatically load 
new data files

ibaAnalyzer searches in a pre-set directory for the measure-
ment file that is currently being written by ibaPDA and loads 
it (process-synchronous analysis).

Locking

Symbol Function Description
Locking Locks view to prevent overwriting.

Only possible in reuse mode, see ì Starting with command 
line, page 20.
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4.3.2	 Customizing the tool bars

You can customize the toolbars according to your needs and make frequently used functions 
quickly and easily accessible.

Customizing the toolbar with the default settings

1.	 Click on the arrow button at the end of a toolbar.

2.	 Go to the desired toolbar via Add or Remove buttons.

3.	 Select the standard buttons that you want to show or hide.

Customizing the toolbar via the dialog
You have the following options for opening the customization dialog:

■	 Click on the arrow button at the end of a toolbar and click on Add or remove buttons –  
Customize.

■	 Open the View menu – Toolbar setup.

Customize toolbar and menu commands
In the Commands tab, you can drag and drop commands from various categories onto a toolbar 
or into a menu in order to insert them there – as in various Windows programs, e.g. MS Office.

As long as the Customize dialog is open, you can add or remove commands from toolbars or 
menus.
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To remove commands from toolbars or menus, drag the commands out of the toolbar or menu. 
You can also change the menu bar in this way, e.g. to remove commands that are not required.

Showing, hiding and creating toolbars
You can show and hide toolbars in the Toolbars tab.

Using the <Reset> button, you can reset the selected toolbar to the default settings. Use the 
<Reset all> button to reset all toolbars.

To create your own toolbars, proceed as follows:

1.	 In the Toolbars tab, click <New>.

2.	 Enter a name for the toolbar and click <OK>.

	→ A floating toolbar without commands appears.

3.	 Drag the toolbar to the toolbar area.

4.	 Go to the Commands tab and drag the desired commands to the new toolbar.

Further customization options
You have the following options in the Menu tab:

■	 Set animation when opening  
The differences regarding animation are only noticeable on close inspection, as this is very 
quick.

■	 Set shadow for menu

■	 Reset menu bar to factory settings

You have the following setting options in the Options tab:

■	 Specify tooltip information (quick info) on toolbars

■	 Display large icons

Define keyboard shortcuts for commands
You can assign keyboard shortcuts to the toolbar commands in the Keyboard tab.

1.	 First, select the command category and then the command to which you want to assign 
a keyboard shortcut. If an assignment already exists, the current keyboard shortcut is dis-
played in the field next to it.

2.	 Click in the field Press new shortcut key and then press the desired keys.

3.	 Click <Assign>.

Using the <Reset all> button, you can reset the default settings.

For more information, see ì Hot keys (keyboard shortcuts), page 52.
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4.4	 Mouse and key commands
The following chapters describe various ways in which you can operate ibaAnalyzer more easily 
and quickly.

4.4.1	 Drag & Drop

At many points in ibaAnalyzer, you can use the intuitive Drag & Drop functionality. Simply click 
and mark the object (file name, signal name, graph, etc.). Then drag the object keeping the 
mouse key depressed and drop it where you want to place it. 

The Drag & Drop function is, for example, available for the following operations:

■	 Adding a data file from the Windows Explorer to the signal tree window of ibaAnalyzer;  
applies also to archived data files (*.pdc, *.zip etc.)

■	 Moving one or more data files into the group window within the Open data file dialog

■	 Moving signals from the signal tree to a new graph or adding signals to an existing graph

■	 Moving signals within the same graph or between different graphs

■	 Moving graphs

4.4.2	 Context menus

ibaAnalyzer offers context menus in various areas of the screen. Context menus contain com-
mands that you can apply to the area in which the cursor is currently located.

These areas include context menus:

■	 Signal tree window

■	 Graphs (trend views)

■	 Axes

■	 Signal grid

■	 Navigator

A click with the right mouse key opens the context menu.
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4.4.3	 Hot keys (keyboard shortcuts)

In addition to using the mouse, you can also use keyboard shortcuts. However, in ibaAnalyzer, 
these shortcuts are mostly limited to standard Windows functions.

If available, the tooltip (quick info) displays additional keyboard shortcuts.

If needed, you can assign custom shortcuts through the menu View – Toolbar setup – Keyboard 
tab, see also ì Define keyboard shortcuts for commands, page 50.

Shortcut Function
<Ctrl> + <C> Copies the currently visible content of the recorder window to the clipboard.
<Ctrl> + <V> Pastes the content previously copied to the clipboard into the recorder win-

dow.
<Ctrl> + <I> Inserts an interval between marker positions X1 and X2.
<Ctrl> + <M> Inserts a static marker at the position of marker X1, visible only in the selected 

graph.
<Ctrl> + <Alt> 
+ <M>

Inserts a static marker at the position of marker X2, visible only in the selected 
graph.

<Ctrl> + <N> New analysis (analysis file *.pdo).
<Ctrl> + <O> Open existing analysis
<Ctrl> + <S> Save current analysis
<Ctrl> + <Z> Undo
<Ctrl> + <Y> Redo
<Ctrl> + <D> Open data file
<F5> Reload data files
<Ctrl> + <P> Opens the print dialog to print out the current view.
<Alt> + <F4> Exits ibaAnalyzer.
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4.4.4	 Combinations of mouse and key operation

In ibaAnalyzer, you can also use a combination of keys and mouse clicks to use certain func-
tions.

LM = left mouse key RM= right mouse key

Key Mouse Function
<Shift> + LM (double click) On signal in the signal tree: Adds the signal to the selected 

graph and appends it to the Y-axes of the bottommost sig-
nal.

<Ctrl> + LM (double click) On signal in the signal tree: Adds the signal to an existing 
and marked graph and gives it its own Y-axis.

<Ctrl> + LM (depressed) In 3D appearance moving/rotating the graph
<Shift> + LM (depressed) In 3D appearance Zoom
<Ctrl> + LM When moving a marker in the marker view:  

Marker locks in at next signal point (can be adjusted in the 
preferences menu).

<Shift> + LM When moving a marker in the marker view:  
Both markers keep on moving simultaneously.

<Shift> + 
<Ctrl> +

LM Combination of both preceding features
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4.4.5	 Tooltips

ibaAnalyzer displays tooltips in various places, which you can also configure accordingly.

Tooltips for the toolbar
If you hold the cursor over a button in the toolbar, a short explanation (tooltip) appears.

You can activate and deactivate tooltips for the toolbar in the View menu – Toolbars – Options 
tab.

Tooltips for the signal legend
If you hold the cursor over the legend of a signal, a tooltip can also appear. To do this, you have 
to activate the function in the preferences or graph setup and define the content of the tooltip.

Available information that you can add to the tooltip of the legend:

■	 FFT prefix

■	 Signal name

■	 Signal unit

■	 Comments 1 and 2

■	 X values of markers 1 and 2

■	 Difference between markers-X-values

■	 Y values of markers 1 and 2

■	 Difference between markers-Y-values

■	 Sampling interval

■	 Expression

For more information about configuring the legend tooltips, see part 2 of the ibaAnalyzer manu-
al, chapter 2D view.
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Tooltips for hidden graphs
If you have hidden a graph in the recorder window, you can display the content of the graph 
(signal names) by placing the mouse pointer over the small triangle (pointing downward = graph 
hidden).
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4.5	 The signal tree window
The signal tree window has multiple functions, which you can select by the tabs on the lower 
edge of the window:

■	 The Signals tab shows the data files that are currently opened – including the signals con-
tained therein.  
See ì Signals tab: Tree with data files and signals, page 56.

■	 In order to find signals inside a data file, you can use the Search tab.  
See ì Search tab: Function for searching signals, page 64.

■	 The Report info tab displays calculated characteristic values or graphics.  
See ì Report info tab: Display of characteristic values, page 65.

■	 The Analysis files tab provides shortcuts for analysis file selection.  
See ì Analysis files tab: Quick access to PDO files, page 67.

The signal tree window has a standard arrangement of sub-windows in the form of tabs. You 
can release each tab with drag & drop and position it as a separate window.

4.5.1	 Signals tab: Tree with data files and signals

The Signals tab shows the currently open data files with the signals they contain. In addition to 
the analog and digital signals, you can also find text channels, virtual signals, logical expressions 
and info columns for the signals here in the signal tree.

Note

Correspondingly, the following explanations also apply to the HD query results.

In order to view the individual signals, click the plus symbol at a module icon.

Tip

If you hover the mouse over the signals, tooltips show the signal comments, pro-
vided they have been configured in ibaPDA.
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4.5.1.1	 Displaying data files in the signal tree

The signal tree window can display data files in different ways. The display method depends on 
how you have opened the data files and which view you select.

Displaying module names or linear numbering

Signal tree with modules Signal tree with linear numbering

The image on the left shows the signal tree with modules. This highlights the technological 
structure of the signals, as specified in ibaPDA, for example. The corresponding module and 
signal trees can be extended for every file. Signal curves of the same signal in different data files 
can be displayed at the same time and compared.

The image on the right shows the linear numbering. All the signals of a data file are listed con-
secutively without the module names. The difference between analog signals and digital signals 
is still visible. The linear numbering option should be used if many signals of the same type and 
belonging to the same technological process units cover several modules, such as the 72 mea-
suring zone values of a flatness measuring roll. This is an advantage for creating arrays or vector 
signals (logical signal definitions) for the presentation of profiles.
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Displaying data files opened in parallel and appended data files
You can open several data files next to each other or attach several data files to each other de-
pending on your application.

Data files opened in parallel Appended data files

As the appended data files are displayed one after the other, the signals of the files are only 
listed once in the signal tree, although each file contains signals. You can also display appended 
data files with linear numbering.

For more information about appended data files, see part 2 of the ibaAnalyzer manual, chapter 
Appending data files.

For more information about opening multiple data files, see part 2 of the ibaAnalyzer manual, 
chapter Opening multiple data files.
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4.5.1.2	 Presentation of expressions

In addition to the original signals from the data file, the signal tree window also displays expres-
sions and virtual signals if you created them in the dialog Logical Expressions or imported them 
with the data file.

Note

In the signal table in the Signal definitions tab, you can also create expressions 
with the expression editor (via Add signals). The signal tree window does not 
display these expressions, and they are lost if you delete these expressions from 
the signal table or if you delete the signals on which the expressions are based.

However, you can also declare each expression as a virtual signal via the Logical 
expressions dialog. The expressions then appear in the signal tree like the origi-
nal signals and are an integral part of the analysis file.
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4.5.1.3	 Other channel types

In addition to normal numerical values, you can also display texts and vectors as signals in the 
signal tree.

Text signals
You can use text signals in the same way as conventional signals. Like the fixed markers, text sig-
nals have an individual designation (flag).

Vector signals
The signal tree window displays vectors in the Expressions node. Vectors consist of individual 
signals combined in groups. If you have created the vector signals in ibaPDA and the signals are 
available in the data file, ibaAnalyzer displays the signals used in the signal tree.

You can also create the vectors later in ibaAnalyzer in the Logical expressions dialog. In this case, 
you cannot find the associated signals in the signal tree, but only in the Logical expressions dia-
log.

For more information on vector signals in ibaAnalyzer, see part 2 of the ibaAnalyzer manual, 
chapter Creating vector signals.
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4.5.1.4	 Context menu in the Signals tab

This context menu basically contains the familiar commands for data files as the File menu, see 
ì The File menu, page 33. Depending on the area where you click, reduced menus may ap-
pear.

Menu commands referring to data files or HD queries usually apply to the file or HD query in 
which the context menu was opened or that was marked at the time the context menu was 
opened.

Important commands in the context menu

Show signal
Use this command to display the signal on which you right-click in a graph.

Show bits
This option is only available for analog signals. Use this command to display the bits of the sig-
nal as individual digital signals. In this way, you can, for example, display digital information that 
is packed into a 16-bit integer signal as individual signals again. This works for 32 bit floating 
point values, too.

Show linear numbering, Show modules
These functions switch between linear numbering and the module view.
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Show groups per file, Show groups over all files
You can use these display options if the signals are already divided into different groups when 
recording the measurement values in ibaPDA. The signal-group-assignments are stored in the 
data file.

Show groups per file: The signal tree window displays the data files at the top level and the re-
spective signal groups below.

Show groups over all files: The signal tree window displays the signal groups as the top level.

In this way, you can define signal groups that contain the signals for a specific analysis purpose, 
regardless of their physical module assignment. The signal name then no longer needs to con-
tain the technological affiliation in order to identify a signal.

Show length and time-based signals separately
This option is only visible if a data file from an ibaQDR system with length-based and time-based 
signals is opened. This option divides the nodes of the measuring locations in the signal tree 
into nodes for length-based signals (L) and time-based signals (T). The nodes of the measuring 
locations with length-based signals automatically receive the numbers x, the nodes of the mea-
suring locations with time-based signals receive the numbers x + 1.

Prerequisite: The archiving profile in the ibaQDR data recording has a length-based and a time-
based store.

ibaQDR data file with length-based signals 
only

ibaQDR data file with length-based and time-
based signals

Time shift data file
This command opens the dialog for configuring the time shift of data files. If more than one file 
is opened in ibaAnalyzer, you can arrange them one below the other.

For more information, see part 2 of the ibaAnalyzer manual, chapter Time shift of data files.

Reload data files
This command reloads the previously selected file in the signal tree window (refresh).



63Issue 8.3

ibaAnalyzer	 User interface

Export file tree/Import file tree
These commands can export the file tree to a text file or import it from a text file.

For more information, see part 2 of the ibaAnalyzer manual, chapter Exporting/importing file 
tree.

Add new HD query
This command adds a new HD query to the signal tree.

Replace File by HD query
This command replaces the (selected) data file or HD query with a new HD query.

Append HD query
This command appends a new HD query to the selected file or HD query.

Export HD query file
This command is only available if the signal tree contains an HD query. This command exports 
the parameters of the HD query to a text file.

For more information, see part 2 of the ibaAnalyzer manual, chapter Export and import of HD 
queries and time periods.

Export
This command opens the configuration dialog for exporting the data files to other file formats.

For more information, see part 2 of the ibaAnalyzer manual, chapter Data export.

4.5.1.5	 Alternative signal names

For displaying the signal names in the signal tree, it is possible to use alternative titles, e.g. to 
display clearer titles or another language. The prerequisite is that corresponding info fields for 
each signal in ibaPDA have already been filled with information, e.g. comment1 and comment2.

For more information, see part 2 of the ibaAnalyzer manual, chapter Signal tree. 
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4.5.2	 Search tab: Function for searching signals

If a data file contains many signals, it can be hard to find a particular signal. The search function 
helps you to find signal names, expressions, logical signal definitions or markers.

To search for signals in general, you can enter a character string from the signal name or the 
comments as a search term. To identify individual signals in a trend view with many graphs, it is 
best to use the target search.

In addition to the columns Nr, Name and Unit (standard), you can also display other columns in 
the results table (Module name, Comment 1 and Comment 2).

For more information, see part 2 of the ibaAnalyzer manual, chapter Searching for signals.
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4.5.3	 Report info tab: Display of characteristic values

The Report info tab of the signal tree window enables the display of calculated characteristic 
values resulting from a measuring series.

You can define the typestyle format (font, character size, color, etc.) individually so that you can 
create a clear and easy-to-read display. The values are determined and provided via the dialog 
for the report generator.

Other documentation

For more information, see the ibaAnalyzer-Reportgenerator manual.
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4.5.3.1	 Displaying images on the Report info tab

In addition to or instead of the calculated characteristic values and info assignments, the tab can 
also display a graphic. In this way, you can integrate a lot of valuable information into the analy-
sis, e.g. about the structure of a machine.

The graphic must be available as a bitmap (.jpg, .png, .bmp, .gif).

1.	 To add a graphic, open the Properties via the context menu of the Report info tab. 

2.	 In the Title area, enter the file path and file name of the graphic file. 

3.	 Confirm the entries with <OK>.
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4.5.4	 Analysis files tab: Quick access to PDO files

On this tab, you can configure a tree structure with an arbitrary number of selectable analyses. 
You can apply each of these analysis files to a loaded data file by a double-click.

In addition, you can add further shortcuts to the analysis tree, e.g. to signals, expressions and 
markers.

For more information, see part 2 of the ibaAnalyzer manual, chapter Quick access to analyses 
and more.

4.6	 The signal table
The signal table, i.e. the lower part of the screen, offers several display and analysis aids to 
quickly display the desired values and additionally create logical signals (expressions) for display. 
The different control levels can be selected via tabs on the lower margin.

The signal table window represents a default grouping of the partial windows as tabs. You can 
release each tab by means of drag & drop and position it as a separate window.

You can adjust the width of the columns in the table. These settings are saved in the analysis 
file.

In the signal table, the lines of those signals that are part of the currently selected graph are 
highlighted gray.
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4.6.1	 Context menu in the Signal definitions tab

Open the context menu with a right mouse click in the tab.

General context menu in the tab Context menu for signals

The context menus differ depending on where they are opened.

If you click in the empty area of the table or on the header, you can perform the following ac-
tions. These actions are also available for individual signals.

■	 Add signals: Adds a new signal as an empty row in the table.

■	 Setup: Opens the preferences for an empty table or the graph setup of the active graph for 
existing signals.

■	 Convert signal numbers to names or Convert signal names to numbers: You can apply this 
function to the selected signal or all signals. In the Expression column, the usual [Mod-
ule:Channel] designations are then replaced with the plain text signal name and vice versa. 
A signal calculation (formula expression) may become more comprehensive but longer as 
well.

■	 Find, Replace: Using these functions, you can search through the configured signal names, 
expressions, comments and units and optionally replace the found occurrences by another 
string.

■	 Import, Export: You can import the signal definitions from a text file or export them to a text 
file.

A right click on a signal row opens the menu as shown in the image to the left. Additionally, you 
can perform the following actions:

■	 Remove signals, Duplicate signals

■	 Create logical: Opens the Logical expressions dialog. The signal name and the expression in 
the line are given as suggestions in the dialog.

For more information, see part 2 of the ibaAnalyzer manual, chapter Signal grid.
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4.6.2	 Markers tab

If you select the Markers tab, two vertical red rulers (X1 and X2) appear in the recorder window. 
You can move these two markers independently from each other using the mouse. When press-
ing the <Shift> key while moving one of the two markers, the other one follows in the same dis-
tance.

The signal table shows the X-values and Y-values for each signal at the markers, as well as the 
difference between the two markers in the X-direction and Y-direction. In this way, the curves 
displayed can be easily measured and time sections can be determined.

Exact determination of individual signal points
Proceed as follows to determine individual signal points exactly or to mark them precisely 
("snapping"):

■	 Enlarge the signal view so that the individual signal points become visible.

■	 Hold down the <Ctrl> key while moving one of the two markers with the mouse: The marker 
jumps to the signal point closest to it on the first signal in the graph. You can thus precisely 
determine each signal point in the X-direction.

■	 If you press the <Shift> + <Ctrl> keys simultaneously while moving one of the two markers 
with the mouse, the second marker follows the first at a constant distance from signal point 
to signal point.

If the signal points are not visible (insufficient magnification of the graph section), these func-
tions are not supported.
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You can also move the markers with the arrow buttons of the keyboard. The following addition-
al functions are applicable:

Shortcuts Function
Arrow keys Marker X1 moves left/right.
<Alt> + arrow key Only marker X2 moves.
<Shift> + arrow key Both markers move simultaneously. 
<Ctrl> + arrow key Marker X1 jumps from signal point to signal point.
<Ctrl> + <Alt>/<Shift> + 
arrow key

Marker X2/both markers jump from signal point to signal point.

Note

Under certain conditions, there may be overlaps of the shortcuts with other hot-
keys on the part of the operating system, which leads to unexpected responses. 
The best way is to try the shortcut to see whether there are unexpected respons-
es.

With Windows 10, for example, if you are using the onboard graphics card, it is 
advisable to deactivate the hot keys for the "Graphics Options", because other-
wise the entire desktop rotates when you press <Ctrl> + <Alt> + arrow key.

You can configure the settings by right-clicking on the desktop:

When using different graphics cards, these menu items may not appear. In this 
case, refer to the documentation about your graphics card.
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4.6.2.1	 Context menu in the Markers tab

Hexadecimal
You can use the context menu to switch the display of the Y-values to hexadecimal values. This 
can be an interesting option if, for example, integer values are used for transmitting binary con-
trol information. The hexadecimal representation helps to identify which bits are set.

The hexadecimal value of the stored data type is displayed.

Find
You can use this command to search through the markers using a text search.

4.6.3	 Statistics tab

This table offers a quick overview of the most important statistical values, i.e. minimum, maxi-
mum, average and standard deviation.

The red markers are also displayed when the Statistics tab is selected. You can use the markers 
to limit an area to which the statistical functions in the signal table should refer. The values in 
the Min, Max, Average and Std dev columns only apply to the range between the two markers. 
When the marker position changes, you can easily see that the values are calculated on an on-
going basis and updated immediately.

This is hence a relatively simple way of determining averages or maximum/minimum values of 
parts of the chart or to exclude invalid values, for example, at the beginning of measurement.

4.6.4	 Harmonic marker tab

This table shows the FFT result values of the main frequency Y(F) and its harmonics for each sig-
nal that is displayed in the recorder window on an FFT axis (1/s or 1/length).

For more information, see part 2 of the ibaAnalyzer manual, chapter Harmonic markers.
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4.6.5	 Navigator tab

The Navigator tab always shows the complete content of the data file with time or length axis 
for the graph appearing at the topmost position in the recorder window.

The red frame in the window represents the section that is visible in the recorder window. This 
helps you to better navigate in the data file, especially when using the zoom function.

In turn, you can adjust the red frame to zoom into the graph. For more information, see part 2 
of the ibaAnalyzer manual, chapter Using the Navigator.

4.6.6	 Overview tab

The Overview tab shows the results of trend queries from databases or from file groups. 

For more information, see part 4 of the ibaAnalyzer manual, chapter Trend queries in Overview 
window.

4.6.7	 Cross-reference tab

In the Reference tab, you can review the use and referencing of input signals and logical expres-
sions. The tab shows a list of all input signals and expressions as well as their use in expressions 
and calculations. You can edit the expressions directly in the Referencing expressions table.
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Input signals table
The Input signals table lists all signals from the signal tree that are referenced. Not referenced 
input signals are not listed. All logical expressions from the Logical expressions dialog are also 
listed, regardless of whether they are referenced or not.

You can sort the table in ascending or descending order by clicking on a column header.

If you double-click on a row in the table, ibaAnalyzer navigates to the origin of the signal and 
highlights it, e.g. in the signal tree or in the Logical expressions dialog.

You can use the <Refresh> button to update the table if the input signals changed.

The columns contain the following:

■	 Name: Name of the input signal

■	 ID: The ID is used in expressions when this signal is referenced.

■	 Count: Number of expressions referencing this signal (corresponds to the number of rows in 
the Referencing expressions table for this signal)

■	 Category: Type of the input signal. The following categories are available:

	� Input signal: Input signal from currently loaded data file

	� Logical expression: Logical expression from the Logical expressions dialog

Not referenced expressions are marked orange. They have a count of "0". To optimize 
the analysis, you can remove the expressions that are not required.

Duplicates in the list are marked in red. There is either a signal or an expression with the 
same name. Duplicates cannot be referenced correctly, so you have to edit the dupli-
cates marked in red.

	� Grid expression: Referenced expression from the signal table 

Grid expressions that reference input signals directly are not listed, as these expressions 
usually only visualize the signal and do not calculate it.

Duplicates in the list are marked in red. There is either a signal or an expression with the 
same name. Duplicates cannot be referenced correctly, so you have to edit the dupli-
cates marked in red.

	� Trend query: Channel that results from a trend query of a database and that appears in 
the signal tree instead of in the overview.

	� View result: Channel that results from ibaInSpectra, ibaInCycle or the calculation module 
and that is referenced. Not referenced channels are not listed.

Referencing expressions table
The Referencing expressions table lists all expressions that reference the selected input signal.

If you double-click on a row in the table, ibaAnalyzer navigates to the origin of the signal and 
highlights it, e.g. in the signal tree or in the Logical expressions dialog.

You can edit expressions directly in this table. Use the <Apply> button to save the changes di-
rectly in the source without having to open the source. Use the <Undo> button to discard all 
unsaved changes.
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The columns contain the following:

■	 Name: Name of the expression

■	 Expression: Expression itself, which you can edit. You can open the expression editor and the 
diagnosis of the expression from here.

■	 Source: Location where the expression is defined. The following sources are available:

	� Grid expression: Expression from the signal table

	� Logical component: Expression with at least one logical component (logical expression)

	� X-axis marker: Calculated static marker

	� X-axis interval: Interval

	� Report Computed Value: Calculated column in the report generator

	� Extract Computed Value: Calculated column in the data extractor

	� X-axis manual scale: Calculated scale of the X-axis

	� Y-axis manual scale: Calculated scale of the Y-axis

	� View input: Input signal of a view e.g. Maps, ibaInCycle, ibaInSpectra, calculation module

	� Empty field: not all possible sources are currently implemented
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4.7	 The recorder window
The recorder window is the central area for value display. The graphs form the basic structural 
element within the recorder window. The program tries to arrange all the graphs in the visible 
area of the recorder window until a minimum graph height is reached and scales them accord-
ingly. If the number of graphs becomes too large, a scrollbar appears on the right margin. The 
figure shows measured values with X-axis modes Time, Frequency, Length and 1/length (from 
above).

You can also manually change the height of a graph using the mouse in the area below the 
scale.

You can display one or more signals in one graph. If several signals share the same graph, they 
always have a common X-axis and either a common or separate Y-axis. (See also part 2, chapter 
Displaying signals.)
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If several graphs are displayed, one of them is active. Active here means that a graph is select-
ed (is in focus) to which certain commands in the menus or on the toolbar are then applicable, 
such as graph settings or automatic color assignment. You can tell which graph is active by the 
shaded header (see image: a is in focus, b is not in focus). 

You can select the basic variable for the X-axis (time, length, frequency or 1/length) separately 
for each graph. Just click the small arrow button to the left of the Y-axis and select the basis. In 
the case of several graphs with different basic variables, there is only one general time axis, one 
length axis and one frequency axis.

You can scale the X-axes and Y-axes (see part 2, Settings chapter).

Note

Clicking the <x> button in the upper left corner of a graph removes the graph 
and its signals from the display. It is then no longer possible to display any de-
rived expressions that were generated in the signal table (Signal definitions). In 
order to hide a graph, click the small arrow on the right margin of the respective 
graph.
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4.7.1	 Context menu in the recorder window

There are different context menus in the recorder window depending on the position of the cur-
sor when the right mouse button is pressed.

Curve area of a graph

As you can see from the picture above, the context menu offers a selection of relevant setting 
options for the graph in question. Further setting options are available for FFT displays.  
In the zoomed-in condition, commands for autoscrolling and zooming out are additionally of-
fered.

For more information, see part 2 of the ibaAnalyzer manual, chapter Settings.

The following menu items allow you to document the displayed signals by copying or exporting 
them.

■	 Export graph image to file

■	 Export graph image to clipboard

■	 Export signal data to text file

■	 Export signal data to clipboard

■	 Copy

■	 Export

For more information, see part 2 of the ibaAnalyzer manual, chapters Using views in other  
programs and Data Export.
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X-axis and Y-axis areas

Y-axis X-axis (time)

To access the context menus for the axes, position the cursor directly on the respective axis.

For more information about axis setup, see part 2 of the ibaAnalyzer manual, chapter Settings.

Options in the context menu of the time axis (picture on the right):

■	 Absolute time (Hours – minutes – seconds notation)  
toggling between absolute and relative time display on the scale.

■	 Synchronize files on recording time  
This option is important in the case of appended files: This option does not append the sig-
nal curves one after the other without gaps but arranges them according to their time stamp 
on the time axis. This allows you to recognize and display recording gaps between two data 
files.

For more information, see part 2 of the ibaAnalyzer manual, chapter Appending data files.

4.8	 Status bar
The status bar, the lowest element of the ibaAnalyzer screen, shows the position of the cursor 
when it is in the curve field. The position indicator allows you to easily read the measured value 
– regardless of the selected register or markers.

Corresponding to the X-axis mode, the X-coordinate also shows the correct physical unit. In the 
case of a time axis, a distinction is made between absolute and relative time.

Status bar, cursor position for graph Example
with time axis: relative time

with time axis: absolute time

with length axis

with frequency axis (FFT)

The third dimensional coordinate also appears in the 2D 
top view (sonogram).

"y" is the index coordinate, for example, the strip width, 
the position of the temperature scanner or the zone num-
ber of a flatness measuring roll for the purposes of a strip 
flatness presentation. "z" represents the value of the real 
measured signal (e.g. thickness, temperature or flatness).

You can switch the status bar on or off in the View menu.
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5	 Support and contact
Support

Phone: +49 911 97282-14

Email: support@iba-ag.com

Note

If you need support for software products, please state the number of the licen-
se container. For hardware products, please have the serial number of the device 
ready.

Contact

Headquarters

iba AG  
Koenigswarterstrasse 44  
90762 Fuerth  
Germany

Phone: +49 911 97282-0

Email: iba@iba-ag.com

Mailing address 

iba AG  
Postbox 1828  
D-90708 Fuerth, Germany

Delivery address

iba AG  
Gebhardtstrasse 10  
90762 Fuerth, Germany

Regional and Worldwide

For contact data of your regional iba office or representative  
please refer to our web site:

www.iba-ag.com
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